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Copyright 
 

©2008 Premier Assistive Technology, Inc.  All Rights Reserved.  This documentation 

and the accompanying software are copyrighted materials.  Making unauthorized copies 

of this material is prohibited by law.  No part of the software or documentation may be 

reproduced, transmitted, transcribed, stored in a retrieval system or translated into any 

human or computer language without prior written permission of Premier Assistive 

Technology, Inc.  Premier Assistive Technology, Inc. asserts its "Moral Right" to be 

identified as the author of this work, in all jurisdictions which recognize the "Moral 

Right." 

 

Trademarks 

 

These other marks include, but are not necessarily limited to the following. Microsoft, 

Windows XP, Windows Vista and Internet Explorer are either registered trademarks or 

trademarks of Microsoft Corporation in the United States and/or other countries. Firefox 

is a registered trademark of the Mozilla Foundation. Google Groups, Google Image 

Search and Iôm Feeling Lucky are trademarks of Google in the United States and/or 

other countries. Premier Literacy is a registered trademark of Premier Assistive 

Technology, Inc. 
 

You shall not use any of the Trademarks, or Service marks of Premier Assistive 

Technology, Inc., Microsoft Corporation, Mozilla Foundation, Google or any other 

entity, without the express written permission of such Trademark or Service mark 

owner. 

 

Notice of Limited Warranty  

 

Unless otherwise provided by written agreement with Premier Assistive Technology, 

Inc., this publication, and the software and equipment sold with this publication are 

provided "as is" without warranty of any kind either expressed or implied, including but 

not limited to the implied warranties of merchantability and fit this particular purpose.  

The entire risk arising out of the use or performance of this publication and software 

remains with the customer.  In no event shall Premier Assistive Technology, Inc., or any 

of its suppliers, be liable for any lost profits, lost savings, direct, incidental or indirect 

damages or other economic or consequential damages, even if Premier Assistive 

Technology, Inc. or its suppliers, have been advised of the possibility of such damages.  

Premier Assistive Technology, Inc. reserves the right to modify this document at any 

time without obligation to notify anyone.  In no event shall Premier Assistive 

Technology, Inc. or its suppliers' liability under this agreement exceed the sum of any 

amounts paid hereunder by the customer to Premier Assistive Technology, Inc. or the 

supplier. 

 



 

Premier Internet Toolbar Manual  Premier Literacy  

www.readingmadeez.com  3 

Deletion or Modification 

 

If any portion of this manual, including but not limited to the "Notice" section above, is 

held to be unenforceable, then that portion shall be deleted, and the remaining language 

shall be given its broadest legal effect. 

 

Premier Assistive Technology, Inc. 

1309 N. William St. 

Joliet, IL 60435 USA 

Phone: 815-927-7390 

Fax: 815-722-8802 

E-mail: info@readingmadeeasy.com  

Web: www.readingmadeez.com 

 

 

System Requirements 
 

The Premier Internet Toolbar requires either Internet Explorer version 5 or higher or 

Firefox 2.0 or higher 

 

Operating System:  Windows XP Home/Pro or Windows Vista 

CPU: 900MHz or faster 

Hard Drive Space: 20MB 

Ram: 256MB or more ï 512 MB or higher is recommended. 

Display Resolution: 1024x768 or higher recommended. 

Internet Access 
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Premier Internet Toolbar 
 

The Premier Internet Toolbar is a custom toolbar designed for Microsoft Internet Explorer and 

Firefox.  The Premier Internet Toolbar provides a variety of useful tools for accessing and 

capturing the Internet more efficiently.  

 

A selectable voice and adjustable speaking rate is provided for each talking product so that it 

can be adjusted to meet your reading requirements. 

 

 
 

The Premier Internet Toolbar includes:  

1. a talking pointer 

2. a talking dictionary  

3. an encyclopedia 

4. a reader  

5. a web grabber with a zoom feature to magnify the web page to your liking 

6. a text summarization utility 

7. a text-to-MP3 file creation utility 

8. zoom in and zoom out features 

9. quick access to other Premier tools you have installed. 
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Premier Internet Toolbar Tools 

 

Talking Pointer - The Talking Pointer is a useful tool for reading text on the Internet.  When 

activated, the Talking Pointer will read aloud any text you point at on the Internet.  It has a view 

window that can be turned on and off and that displays the word which is being spoken aloud. 

The Talking Pointer can also translate the text on-the-fly to several different languages ï 

English, French, Spanish, Portuguese, Italian and German. 

 

Talking Dictionary  - The Talking Dictionary, which comes complete with a built-in thesaurus 

and word interlinking, makes finding a word easy.  Unlike other dictionaries that take you to a 

separate website, the Premier Talking Dictionary will display and read the definition aloud in a 

pop up window. Highlight the word in question, and click the Dict. button on the toolbar to hear 

and/or view the definition.   

 

Web Grabber - The Web Grabber is used to capture a web page.  The Web Grabber allows 

you to grab and save an entire web page for later use.  The web page is saved in a compact PDF 

file format.  This single file format makes it easy to save and/or email.  In addition, the Web 

Grabber has a built-in PDF editor which enables the merging of multiple files into a single file.  

It also allows pages to be deleted from a PDF file. 

 

Encyclopedia - The Premier E-Pedia button provides you direct access to the Slider Online 

Encyclopedia.  The encyclopedia simplifies online research and, when used in conjunction with 

the Web Grabber, allows you to quickly save the information for future use. 

 

Text To MP3 ï The Text To MP3 tool will let you create either MP3 or Wave files.  An MP3 

file is a smaller, more compact file. An MP3 file, compressed with 128 bit sampling rate, will 

be about a third of the size of a comparable Wave file. 

 

Summarize IT  ï Summarize IT is a reading tool designed to help you efficiently wade through 

the volume of information on the Internet.   The Summarize IT tool will summarize articles on-

the-fly, saving you time by letting you quickly read a very accurate summary of an article. 

 

Reader - The Reader is useful for reading long articles. It is a selective reader which means you 

can select the text you want to read and click the Reader button on the toolbar to hear the text 

read aloud.  

 

Zoom - The Zoom In and the Zoom Out features let you reduce or enlarge the site with the click 

of a button. 

 

Google Search Tools ï The Google search options included on the Premier Internet Toolbar 

provide quick, direct access to search results for a standard Google search or search results for 

images. Also included is an option to go directly to the first web page returned for your query 

and an option for quick access to group discussion forums. Visit Google.com for additional 

information on these Google tools. 
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Premier Tools ï The Premier Internet Toolbar comes with a direct link to the standard Premier 

Toolbar.  If you own any of Premier Literacyôs other products, the direct link feature will 

display a toolbar with all the Premier Tools you have installed.   

 

Installing the Premier Internet Toolbar 

 

Prior to installing the Premier Internet Toolbar, ensure that all other programs have been 

closed.  If you have downloaded the installation file from the website, double-click the 

downloaded file to start the installation.  If you received the Premier Internet Toolbar on a CD, 

put the CD into the CD-ROM drive to begin the installation. 

 

Once the installation has started, follow the prompts until it has completed the setup. You will 

see two different installation screens. The first part of the install copies the necessary files for 

all the tools to your hard drive. The second screen appears as soon as you have completed the 

first part of the installation. The second installer installs the toolbar so that it will be displayed 

when Internet Explorer or Firefox is launched. 

 

When the installation is completed, your browser will start automatically.  If you are using 

Internet Explorer and the Premier Internet Toolbar is not displayed when Internet Explorer 

starts, go to the View menu, select Toolbars and then select Premier Tools. 
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Using the Premier Internet Toolbar 

 
The Premier Internet Toolbar comes complete with built-in help options to show you how to 

use the Internet tools.  Each tool has its own short video to quickly demonstrate the features of 

that program.  To access the videos, open your browser. On the left part of the toolbar, you will 

see the Premier Lit. button.  To the right of the Premier Lit. button, you will see a down arrow. 

 

 
 
Select the down arrow to see the menu options. 

 

 
 
The Premier Tools option is linked to the desktop version of Premier Literacy Tools. When you 

select this option, it launches the Floating Toolbar that will display all the other Premier Tools 

that are installed on your computer. (See Appendix A for information on tools included in the 

Literacy Productivity Pack.) 

 

Selecting the Premier Tools Training Videos option provides access to Premierôs training 

videos.  The What is New AT Premier option re-directs you to the portion of the Premier 

Literacy website that lists new developments at Premier. 
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Talking Pointer 
 

The Talking Pointer reads any text at which you point and works with any available SAPI 5 

compatible voice on your computer. You can select a voice and the rate at which it speaks. 

There are two features that are accessed through the Options button:   1) the reading window 

that shows the words as they are spoken and 2) the option to translate the text that is spoken. 

 

To start the Talking Pointer, open your web browser and click on the Talking Pointer button 

.  

The mouse pointer will not look any different but a small floating toolbar will appear.   

. 

 

The Talking Pointer is turned off when this window is closed.  

 

The Talking Pointer will talk when the mouse is held over any text displayed in the web 

browser.  In the center of the toolbar you will see the Delay box and drop-down arrow. This box 

displays the time you must hold your mouse over the text before it begins to read.  The delay 

can range from .25 to 3 seconds.  The delay is built -in so that it will not talk until you point at 

something for the specified length of time.  Click on the Stop button to temporarily turn off the 

voice.  Click the Start button to re-start it.  Closing the toolbar will unload the Talking Pointer.  

The Talking Pointer can be re-activated by clicking on the Talking Pointer button again. 

 

Talking Pointer Options 

 

The Talking Pointer can customize the following options to suit individual preferences. 

 

¶ Voice  

¶ Speaking rate 

¶ Translation 

¶ Reading window 

 

Select the Options button from the toolbar to display all the options available for the Talking 

Pointer. 
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Select the OK button to close this window and save the changes.  The changes will remain the 

default until they are changed again.  Select the Cancel button if you do not want to save the 

changes. 

Voices 

The drop-down Voices list displays the current voice. Select the down arrow to display all of 

the available voices on your computer.  Select the desired voice.  Click the Test button to hear 

how the voice will sound.   

Voice Rate 

The speaking rate of the selected voices can be adjusted by moving the Voice Rate slider to the 

left to slow the speaking rate and by sliding it to the right to increase the speaking rate.  The 

default is ñ0ò.  At this rate, the voice reads about 170 words per minute.  Adjust the slider to the 

desired rate.  Click the Test button to hear how fast it will read. 

Translation 

Web pages can be read in a choice of six different languages.  Place a check mark in the box 

next to ñAutomatically Translate Textò to activate the translation feature. 

 

 
 

Select the desired translation option from the drop-down menu. When using the translation 

option, it is necessary to ensure the selected voice matches the selected translation option.  For 

example, if  you are translating from English to French a French voice must be selected in order 

for the text to be read properly. 
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Reading Window 

The Talking Pointer will read any text at which you point.  To activate the Reading Window, 

place a check mark in the box marked Display Reading Window Below Pointer.  

 

 
 

When the Reading Window is activated, a small floating window will be displayed just below 

the pointer.  Text that is being read aloud appears in the floating window.  The default font size 

for the displayed text is 8 point font but can be adjusted up to 32 point. 
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Internet Toolbar Dictionary 
 

The Internet Toolbar Dictionary utilizes the Premier award-winning dictionary - the Ultimate 

Talking Dictionary.   

What is the Ultimate Talking Dictionary? 

 

The Ultimate Talking Dictionary (UTD), first and foremost, is a comprehensive dictionary.  A 

standard desktop dictionary contains approximately 110,000 words with definitions.  The UTD, 

with more than 250,000 words, includes sentences using each defined word in context, for every 

ñsenseò (i.e., meaning) of the word. It includes slang, jargon, and such historic figures as 

George Washington.  The UTD also has a fully-integrated thesaurus for referencing synonyms 

and antonyms of all words. 

 

More than a Dictionary ï INTERLINK Technology 

 

The UTD is more than just a dictionary.  INTERLINK technology allows you to search words 

without knowing the correct spelling.  If you try to look up a word that you have misspelled, the 

ñDid You Mean?ò list appears, giving you a list of words that you may have meant to spell.  

Use the up and down arrow keys to move through the list and to hear each possible word.  If 

you find the word you want, simply press the Enter key to look it up.   

 

Premier INTERLINK technology also allows you to search by description or by concept to 

ensure success even when you are unsure of the exact word you seek.  For example, if you 

require the name of a specific cloud enter the word ñcloudò.  The UTD will give you a 

definition of the word ñcloudò as well as a list of all the different types of clouds.  In another 

example, you can start by looking up ñskyò; you can view all the parts of the sky such as 

ñrainbowò and ñcloudsò.  You can then select ñcloudsò and then view the types of clouds.  Use 

the arrow keys to navigate through the search results and listen to pronunciation of the word 

describing the desired cloud.  Once you hear the word youôre seeking, press the Enter key to 

look up the definition of that cloud to verify that this is indeed the type of cloud you were 

thinking about.  Using this approach, you can find a definition of an acorn just by looking up the 

word ñtreeò. 

 

These powerful search algorithms are enabled by Premierôs INTERLINK technology.  The 

technology "interlinksò all the words in the UTD in a myriad of ways to allow cross-referencing 

on a variety of relational levels so that it is easy to find a word by knowing a concept or related 

idea.  INTERLINK technology allows you to navigate through word relationships until you find 

the exact word you seek.    
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Features of the Dictionary 

 

250,000 words ï The UTD comes complete with over 250,000 words.  When a word definition 

is provided, it is always accompanied by a sentence using the word in context for each sense / 

meaning of the word.  The definitions are clearly written so that they can be understood by all 

age groups. 

 

Spelling ï The UTD allows you to search words without knowing the correct spelling.  If you 

misspell a word, the dictionary will ñpredictò the word you are trying to spell and present you 

with a list of potential matches.  Once you ñselectò the desired word from the list of possible 

matches, the UTD will read aloud the word you have selected so you can be sure that it is the 

correct word. The Premier dictionary also retrieves and displays the definition for you. 

 

Reading - The UTD will read the possible definitions aloud so that you can hear each possible 

meaning for the word.  It will read aloud a sentence for each meaning of the selected word.  It 

can also highlight the word on the screen as it reads.  Both the ñsynonymò list and the ñword 

predictionò list speak.  You only need to click on a word and it will be read to you. 

 

Power Search - A ñpower searchò will provide a list of all the words that contain the entered 

sequence of letters.   Listen to the list and when you hear the desired word, simply click on it to 

select and hear it read to you. 

 

Thesaurus - Dictionaries and thesauruses have almost always been separate books / documents.  

The UTD, however, has a built-in thesaurus and will automatically look up alternative words 

(synonyms) each time you search a word.  If you want to hear a definition of a synonym, 

double-click it. 

 

Hot Key Word Lookup :  Definitions are only a keystroke away.  The UTD will  work with 

virtually any program.  To look up a word, all you have to do is highlight it in your current 

application (i.e., email, word processing, Internet), press the F11 key and the definition of the 

word will be read aloud. The UTD can be set up so that it automatically reads a definition to 

you.  The Premier dictionary gives you access to a dictionary that does not require you to stop 

what you are doing just to go elsewhere to look up the meaning, synonyms, and/or antonyms of 

a word.   

 

Zoom - In order to squeeze the maximum number of words into a dictionary, many publishers 

often print dictionaries using smaller fonts than a person would typically find in a newspaper, 

magazine or book. The UTD can be made into a large print dictionary without any reduction of 

its total contents. The ñzoomò feature allows you to enlarge the print up to 400% of its original 

size to meet your needséall this while NOT reducing the number of words in the UTD. 

 

Word History  - The UTD keeps a current ñword session historyò. The Premier dictionary 

keeps a history of all the words you look up in a particular online session so that you can easily 

go back to the previous word just by clicking on the Back button. It is similar to using the Back 

button in a web browser. 
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Accessibility - The UTD is designed to work with screen readers and screen magnifiers.  The 

voice can be ñturned offò so that it will not interfere with a screen reader voice.  The Premier 

UTD can also be used with simple keyboard commands and does not require the use of a 

mouse. 

 

Antonym Support - The UTD has very robust antonym support. The antonym support is 

powerful because it matches up the correct antonym with the correct sense of a word.  It will 

also display it in a sentence so that you will understand how that antonym could be used. 

 

How does it work? 

 

You can use the UTD in several ways.  You can use it as a traditional dictionary where you type 

in a word and a definition is provided.  It can also be used to grab a word on a website and 

automatically look up that word. 

 

Each time the UTD looks up a word, it automatically uses its powerful thesaurus to try to find 

any synonyms for that word.  The dictionary and thesaurus are truly integrated.   To find a 

definition of a synonym, simply double-click it.  The built-in ñbackwardò and ñforwardò options 

allow you to easily get back to the original word by moving through the word history list. 

 

Sometimes dictionaries produce more questions than they answer. If you are presented with a 

definition that contains words you do not understand, highlight the word you do not understand, 

press the F11 key and that new wordôs definition will be presented to you.  To get back to the 

previous word, press the Back button. 

 

We often understand something better when we hear it.  The UTD will read the definitions 

aloud. This is extremely helpful for those who have reading difficulties or are learning English 

for the first time. As it reads, it will highlight each word in the definition to help you follow 

along.  The UTD provides several options on how it will read.  The voice can even be turned 

off. 

 



 

Premier Internet Toolbar Manual  Premier Literacy  

www.readingmadeez.com  16 

The Program 

 
The Ultimate Talking Dictionary (UTD) only has one main screen, to keep the interface simple.  

The toolbar at the top of the screen contains all the major functions for the UTD. 

 

 
 

You will find almost everything you need on the toolbar. Each button on the toolbar has a 

keyboard alternative, so if you canôt use the mouse, you can still activate them with a simple 

keystroke.  The window is separated into several main sections:  

¶ Toolbar  

¶ Word lookup area ï In the Lookup Word field located below the Toolbar, type in 

the word you want to look up and then press the Enter key. 

¶ Definition area ï All definitions for a word appear in the Definition area.  

Definitions are always presented in this order: the noun senses, then the verb senses, 

followed by adjectives and adverbs.  You can hear the definition by clicking on the 

Read button or pressing the F6 key.  You can also use your arrow keys to read line 

by line. 
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¶ Synonym List ï Each time a word is searched, the UTD finds as many synonyms as 

it can and puts them in this list. If you want to find a definition of a word in the 

synonym list, double-click it and the definition will appear in the list. 

¶ Additional Information ï Information related to the word you entered may also 

appear in the tabs at the bottom of the screen. 

 

Additional Information for Searched Words 

 

When you look up a word the dictionary will provide you with more information than just the 

definition. 

Parts 

 

After you have looked up a word, it gives you a series of tabs across the bottom of the screen. 

The number of tabs displayed may vary based on the word being searched.  Some words may 

not be a part of anything.  In the case of ñcloudò, on the ñPartsò tab you will see the parts that 

make up a cloud.  In this case you will see water vapor. 

 

 
 

Type of 

There is a ñType ofò tab.  This is a list of words or phrases that are used to describe the word.  

They should not be confused with a synonym.  The ñType ofò list can be further narrowed by 

using the ñLook Forò feature located in the upper right hand part of the screen.  The ñLook 

Forò list also allows you to narrow the ñType ofò list to nouns, verbs, adjectives or adverbs. 
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Types 

 

Types are very useful.  The ñTypesò tab, for example, will list all the particular types of clouds 

when the word ñcloudò is searched. You can narrow your search by selecting the type of word 

you require from the ñLook Forò li st.  You can search just the noun, verb, adverb or adjective. 

 

 
 

Part Of 

 

ñPart ofò is a powerful and fun feature that can be used when you are unsure of the exact word 

you require. For example, if you want to know a word for what a ñstarò is part of, you can 

search for ñstarò and then view the ñPart ofò tab. Further information can also be found by 

selecting other tabs to see the types of stars.   

 

 
 

See Also 

 

In standard dictionaries, you will often see a section call See also.    The See also section gives 

you a list of words that may give you additional information. 
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Antonym 

The antonym tab will only appear if there is an antonym for the word you searched. 

Look For 

 

ñLook Forò is a drop-down list that you can select what specific type of word you require.  By 

default, when you search a word it gives you all senses of the word.  This includes nouns, verbs, 

adjectives, adverbs, pronouns, conjunctions, prepositions and interjections.   

 

File Menu 

 

In the File menu, you will find everything you need to create a new search, do a power search, 

print a definition or exit the program. 

 

New Search:  You can activate a new search by pressing CTRL + N.   This will clear the 

screen.  You do not need to do this for every search.  Just type in the new word you want to 

search and click on the Look Up button or press the Enter key. 

 

Print:  If you select Print or press CTRL + P the current definition is printed. 

 

Print Preview:  The print preview will display a full-page view of how the printout will look.  

You can also select which printer you want to use by clicking on the Print button from this 

page. 
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Power Search:  The Power Search is a feature that allows you to search for a word when you 

only know how to spell part of the word.  You can select ñpower searchò from the file menu or 

you can click on the Power button .   A Power Search will provide a list of all the words 

that contain the entered sequence of letters.   Select the search method you desire.  Click the 

Lookup button and a list of words will appear in the Definition box. 

 

 
 

Scroll or arrow up and down through the list to find the word you want. When the desired word 

is highlighted, press the F11 key and the UTD will look up the word for you. 

 

 
 

 

Close - When you select this menu item, it will close the UTD. You must select the dictionary 

button again to open it up once it is closed. 
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Exit - When you select Exit from the file menu, this will shut down the UTD and removes it 

from the system tray.  You must restart UTD to use it again. 

 

Edit Menu 

 
Cut - To cut text from the definition window, select the desired text you want to cut and then 

select Cut from the Edit menu.  Additionally, you can use the standard Windows command of 

CTRL+X. 

 

Copy - To copy text from the definition window, select the desired text you want to copy and 

then select Copy from the Edit menu.  Additionally, you can use the standard Windows 

command of CTRL+C. 

 

Paste - To paste text into the definition window, place the cursor where you want to paste the 

text and then select Paste from the Edit menu.  Additionally, you can use the standard Windows 

command of CTRL+V. 

 

Copy Word - To copy the word you just looked up to the clipboard press the F9 key or click on 

the Copy button.  This will only copy the word that is currently in the lookup field, and place it 

on the clipboard.  Once the word is on the clipboard you can paste it into any other application. 

 

Select All  - To select all the text in the definition window, place the cursor in the definition 

window and select the Select All item from the menu.  Additionally, you can use the standard 

Windows command of CTRL+A. 

 

Settings Menu 

 

Voices  - The UTD can access any SAPI 5 voice on your computer.  You can change the voices 

at any time by clicking on the Voices button.  This will open the Voice Options window. 

 

 
 

Click on the Voices drop-down arrow and scroll through the list of voices until you find the one 

you want.  As you select a voice, the voice will speak so you can hear what the voice sounds 

like. 
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Once you have selected the desired voice, you can adjust the rate by moving the slide bar to the 

right for faster and left for slower.  (You can also use your LEFT ARROW or RIGHT ARROW 

keys to adjust the slide).  Select the Test button to hear how the new settings sound.  The Rate 

can be adjusted from a ï10 to 10, with 0 being the default.  You only have to set the voice when 

you want to change.  The system remembers the last setting each time you start the system.  

Once you find a voice setting that you are comfortable with, you will rarely need to change it 

again. 

 

Select the OK button to close the window and save the changes.  Selecting the Cancel button 

will close the window without saving any of the changes. 

 

 

Zoom - The zoom feature allows you to make the UTD a ñlarge printò dictionary.  To enlarge 

the font, you can select Zoom from the Options menu or you can click on the Zoom button 

.    

 

Each time you click on the Zoom button, it will enlarge fonts of all the screen areas including 

the Lookup Field, Synonym Field and the Definition area.  The font size ranges from 8 point to 

18 point.   Once you get to the largest setting, it will cycle back to the smallest setting, so just 

keep clicking until the text is the desired size.   The UTD keeps this setting so that the next time 

you open UTD you will not have to adjust the zoom level. 

Options - If you select Options from this menu or if you click on the Options button , 

additional options are available to adjust how the UTD reads to you. 

 

 
 

There are four options within this window and each item is turned on or off by the check box. If 

there is a check in the check box, the option is turned ON. 

 

Voice On - If this is not checked, all voice activity is stopped.  It is recommended that this 

option is turned OFF when using other screen reader software.  The default is ñONò. 

 

Automatically Read Definition - If this option is turned ON, the UTD will start reading the 

definition aloud as soon as it is has been retrieved.  To hear the definition, you do not need to 

click on the Read button.  The default is ñONò. 
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Read Line By Line - If you want to use the arrow keys to read one line at a time in the 

definition area, this option should be ON. The default is ñONò. 

 

Turn On Word Tracking  - When this option is ON, the words will be highlighted when the 

UTD is reading to you. 

 

Read Menu 

Read - When you press the F6 key or click on the Read button , the UTD will read the 

definition aloud.  It starts from the beginning and will read to the end of the definition. 

 

If you want to read only a part of the definition, just click in the definition area where you want 

to start reading and then use the up and down arrow keys to read the next or previous line. 

 

 

Stop - Press the F7 Key or click on the Stop button  if you want the UTD to stop 

reading.  If you click the Read button again, it will start reading from the beginning. 

 

Pause - Press the F8 Key or click on the Pause button  to temporarily stop reading, but 

still hold your place in the document.  When ready to resume reading where the cursor was 

paused, simply click on the Read button again. 

 

Backward - The UTD keeps a ñword historyò.  This allows you to keep a list of all the words 

you have recently looked up.  You can use your Back button  or press CTRL + B to go 

back through the list of words.  The word history is kept in a drop-down list labeled 

ñLookupò .  To see your history, click on the arrow at the right end 

of the Lookup field and it shows you the complete list.  You can go to the definition of any word 

in the list just by clicking on it. 

 

Forward  - Use the Forward  or press CTRL + F to go forward through the word history 

list.  This works in the same manner as a web browser in that when you get to the most recently 

used word, it will not go any further forward. 
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Help Menu 

 
Help - This entire manual is available in a standard text file.  To activate the Help, you can 

select Help from the menu, press the F1 key, or click on the Help button . 

 

Help About - To see what your software version number is for this package or if you need 

technical support contact information, select the About option from the Help menu. 

 

 
 



 

Premier Internet Toolbar Manual  Premier Literacy  

www.readingmadeez.com  25 

Premier Web Grabber 
 

The Premier Web Grabber is a utility used to capture web pages from the Internet and save 

them as PDF files for easy storage and retrieval.  Typically, when you try to save a web page, 

the web browser gives you the option of saving it as text or HTML.  If you save it as text all the 

images are lost, and if you save it as HTML the web page is saved into many different files and 

folders. When a saved web page is opened, much of the formatting is often gone.  The Premier 

Web Grabber allows you to save a web page exactly as you saw it and save it in a single easy-

to-manage file. 

 

The Web Grabber can capture a web page with a single click.  Start the Web Grabber from the 

button on the Premier Internet Toolbar. 

 

 
 

When the Web Grabber opens it will ñgrabò the current URL and put it in the URL field in the 

Web Grabber window.  If you have two instances of your web browser open it may grab the 

URL from one you didnôt intend to grab.  If that happens, close the extra web browser 


